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Preface

Thank you for purchasing this Topcon product. The materials available in this Manual (the “Manual”) have been
prepared by Topcon Positioning Systems, Inc. ("TPS") for owners of Topcon products, and are designed to assist
owners with the use of the hardware and/or software product (the “Product”), and its use is subject to these terms
and conditions (the “Terms and Conditions”).

@ Please read the terms and conditions carefully.

Terms and Conditions

Preface

Use

This product is designed to be used by a professional. The user should have a good knowledge of the safe use of
the product and implement the types of safety procedures recommended by the local government protection
agency for both private use and commercial job sites.

Copyrights

All information contained in this Manual is the intellectual property of, and copyrighted material of TPS. All rights
are reserved. Do not use, access, copy, store, display, create derivative works of, sell, modify, publish, distribute,
or allow any third party access to, any graphics, content, information or data in this Manual without TPS’ express
written consent and may only use such information for the care and operation of the Product. The information
and data in this Manual are a valuable asset of TPS and are developed by the expenditure of considerable work,
time and money, and are the result of original selection, coordination and arrangement by TPS.

Trademarks

MR-2, TRU™, HD2, Topcon® and Topcon Positioning Systems™ are trademarks or registered trademarks of TPS.
Windows® is a registered trademark of Microsoft Corporation. Other product and company names mentioned
herein may be trademarks of their respective owners.

Disclaimer of Warranty

EXCEPT FOR ANY WARRANTIES OFFERED BY THE ORIGINAL EQUIPMENT MANUFACTURER, THIS MANUAL AND
THE PRODUCT ARE PROVIDED “"AS-IS.” THERE ARE NO OTHER WARRANTIES. TPS DISCLAIMS ANY IMPLIED
WARRANTY OF MERCHANTABILITY OR FITNESS FOR ANY PARTICULAR USE OR PURPOSE. TPS AND ITS
DISTRIBUTORS SHALL NOT BE LIABLE FOR TECHNICAL OR EDITORIAL ERRORS OR OMISSIONS CONTAINED
HEREIN; NOR FOR INCIDENTAL OR CONSEQUENTIAL DAMAGES RESULTING FROM THE FURNISHING,
PERFORMANCE OR USE OF THIS MATERIAL OR THE PRODUCT. SUCH DISCLAIMED DAMAGES INCLUDE BUT ARE
NOT LIMITED TO LOSS OF TIME, LOSS OR DESTRUCTION OF DATA, LOSS OF PROFIT, SAVINGS OR REVENUE,
OR LOSS OF THE PRODUCT’S USE. IN ADDITION TPS IS NOT RESPONSIBLE OR LIABLE FOR DAMAGES OR COSTS
INCURRED IN CONNECTION WITH OBTAINING SUBSTITUTE PRODUCTS OR SOFTWARE, CLAIMS BY OTHERS,
INCONVENIENCE, OR ANY OTHER COSTS. IN ANY EVENT, TPS SHALL HAVE NO LIABILITY FOR DAMAGES OR
OTHERWISE TO YOU OR ANY OTHER PERSON OR ENTITY IN EXCESS OF THE PURCHASE PRICE FOR THE
PRODUCT.

P/N: 1011907-01 vi



Preface

License Agreement

Use of any computer programs or software supplied by TPS or downloaded from a TPS website (the “Software”)
in connection with the Product constitutes acceptance of these Terms and Conditions in this Manual and an
agreement to abide by these Terms and Conditions, and any end user license agreement accompanying the
Product. The user is granted a personal, non-exclusive, non-transferable license to use such Software under the
terms stated herein and in any case only with a single Product or single computer. You may not assign or transfer
the Software or this license without the express written consent of TPS. This license is effective until terminated.
You may terminate the license at any time by destroying the Software and Manual. TPS may terminate the
license if you fail to comply with any of the Terms or Conditions. You agree to destroy the Software and manual
upon termination of the use of the Product. All ownership, copyright and other intellectual property rights in and
to the Software belong to TPS. If these license terms are not acceptable, return any unused software and
manual.

Confidentiality

This Manual, its contents and the Software (collectively, the “Confidential Information”) are the confidential and
proprietary information of TPS. You agree to treat TPS' Confidential Information with a degree of care no less
stringent that the degree of care you would use in safeguarding your own most valuable trade secrets. Nothing
in this paragraph shall restrict you from disclosing Confidential Information to your employees as may be
necessary or appropriate to operate or care for the Product. Such employees must also keep the Confidentiality
Information confidential. In the event you become legally compelled to disclose any of the Confidential
Information, you shall give TPS immediate notice so that it may seek a protective order or other appropriate
remedy.

Website; Other Statements

No statement contained at the TPS website (or any other website) or in any other advertisements or TPS
literature or made by an employee or independent contractor of TPS modifies these Terms and Conditions
(including the Software license, warranty and limitation of liability).

Safety
Improper use of the Product can lead to injury to persons or property and/or malfunction of the product. The

Product should only be repaired by authorized TPS warranty service centers, or the Original Equipment
Manufacturer.

Miscellaneous

The above Terms and Conditions may be amended, modified, superseded, or canceled, at any time by TPS. The
above Terms and Conditions will be governed by, and construed in accordance with, the laws of the State of
California, without reference to conflict of laws.

P/N: 1011907-01
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Manual Conventions

This manual uses the following conventions:

Convention Description Example
Bold Menu, or drop-down menu selection File » Exit (Click the File menu and click
Exit)
Name of a dialog box or screen From the Connection screen...
Button or key commands Click Finish.
Mono User supplied text or variable Type guest, and click Enter.
Ttalic Reference to another manual or help document | Refer to the 7opcon Reference Manual.

@@S
9,
\ 4

Preface

Further information to note about system configuration, maintenance, or setup.

Supplementary information that can have an adverse affect on system operation, system
performance, data integrity, measurements, or personal safety.

Notification that an action has the potential to result in system damage, loss of data, loss of
warranty, or personal injury.

P/N: 1011907-01
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Introduction

The MR-2 receiver from Topcon is a rugged GNSS modular receiver that delivers proven Topcon Vanguard and
HD2 technology in a compact and easy to integrate package. The MR-2 receiver incorporates 226 universal
tracking channels and is capable of tracking GPS, GLONASS, Galileo, BeiDou, and QZSS signals along with SBAS
and L-band augmentation satellites. Dual antenna input support on the receiver extends capabilities to enable
precision heading determination (and inclination) in addition to RTK positioning.

Figure 1: MR-2 — Front View

@g Figure 1 for representation purposes on. Final unit will be different.

Receiver Features

The MR-2 offers complete IP67 protection against dust and water ingress, in addition to superior resistance to
vibration and shock. The Topcon communication interface allows you to quickly integrate Topcon‘s premium GNSS
performance within new systems and quickly deliver world-class positioning and navigation support to your
applications.

The MR-2 features include:

* Vanguard technology for future proof tracking of GPS, GLONASS, Galileo, BeiDou, and QZSS satellite signals
® 226 universal tracking channels
* Proven Topcon GNSS technology delivers precise RTK positioning at up to 100 Hz

¢ Dual antenna inputs support superior heading and determination simultaneously with RTK using Topcon’s HD2
technology

¢ Simple and robust communication interface supports easy system integration and setup

* High speed Ethernet communication

* High-performance signal acquisition and tracking in the most challenging environments

* 1PPS (pulse-per-second) — a signal providing a very accurate reference source for external devices

Introduction P/N: 1011907-01 1



Unpacking the Receiver

When you unpack the MR-2 receiver, verify that your receiver is not damaged from shipment. If it is damaged,
contact your Topcon dealer or Topocon technical support (see “Getting Technical Support”). After you unpack
your receiver, visit myTopcon (https://www.topconpositioning.com/support) and download the following items.

3
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* Warranty card
* Topcon Receiver Utility (TRU) software with online help embedded in the software
* TPStoRinex
¢ Topcon Link
® Occupation Planning
* MR-2 Operator’s Manual
* GNSS Receiver Interface Language (GRIL) Reference Manual
¢ B125 Integrator's Guide
You can purchase the following accessories for the MR-2 receiver from Topcon:

* (able, Power/Charger (P/Ns):
—14-008052-01 (US)
— 14-008053-01 (AUS)
- 14-008054-01 (EUR)
* Power supply with 48-in. Safeco connector (p/n: 22-034101-01)
¢ External antenna, such as the Topcon PG-F1
¢ External antenna cable
® Serial cable — included with the device (p/n: 14-008207-02)
* Power Adapter — included with the device (p/n: 1000231-01)
¢ QOptional Ethernet cable (p/n: 1008816-01)

Getting Technical Support

Before contacting a Topcon customer representative, see “Troubleshooting” on page 53 for some solutions that
may fix issues you might have with the receiver.

Contact your local Topcon dealer or visit the myTopcon website at https://www.topconpositioning.com/support
for technical support.

@@ For quick and effective support, provide a detailed description of the problem.

When contacting Topcon for technical assistance, provide the following information:

1. A description of the following
— Field operation that was being performed when the problem occurred.
— Details of the unexpected behavior, symptoms, and any error messages that precede or follow the
problem.
— Problem occurrence and frequency or patterns.

2. Receiver information and configuration settings. For receiver information, click Information in TRU,
select Save to File, enter a file name, and save it to the computer.

3. Specifications of mobile devices and computers used in the field or office exhibiting the problem. These
specifications should include model information, version number, operating system information, memory
and storage capacity, etc.

4. Information about the system software, including the version number and steps to reproduce the problem.

5. A description of the field environment and/or observation conditions when the problem occurred.

Unpacking the Receiver P/N: 1011907-01 2




Website

The Topcon website provides current information about Topcon’s line of products. The support area of the
website provides access to Topcon field and office software, manuals, frequently asked questions, and so forth.
To access the Topcon website, visit http://www.topconpositioning.com.

The myTopcon website also provides complete support, such as news, updates, reminders, training, live
webinars, product registration, and customer service to help you get the information you need.
Visit https://www.topconpositioning.com/support.
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Getting Acquainted

This chapter describes the standard components and accessories included with your receiver.

Communication and Power Port

Both the serial and Ethernet communication connectors of the MR-2 feature a power input.

Power Input

The serial and Ethernet connectors on the MR-2 accept an external 9 to 36 VDC power source. Connect the
MR-2 to a power source to turn on the receiver. When the LED is lit solid, the MR-2 is receiving power. Disconnect
the MR-2 from the power source to begin the shutdown process. The power LED will remain on until the end of
the shutdown process (see “Turning the Receiver On/Off” on page 19 for more information).

Com Features

* Supports serial data using EIA RS-232C-level signals.
¢ Supports baud rates of 115,200 and higher.
* Supports RS232 RX and TX signals.

¢ Supports simultaneous output of position and status data along with input of control commands and/or
differential corrections for RTK.

® Supports CAN
* Supports GNSS board firmware upgrades.
* Supports input of differential RTK corrections from an external radio source.

PPS Connector

Modern synchronization and time transfer applications require a highly-reliable timing source. The MR-2 supports
a 1PPS (pulse-per-second) signal, which provides a very accurate reference source for external devices. You can
program the period, offset, edge, and time reference of the 1PPS signal using GRIL commands.

The 1PPS signal has the following attributes:

* Amplitude (on 50 Ohm load): >=2 Volts
* Polarity: Positive
¢ Normal pulse width: 3.3 ms

Ethernet Connector

Attach the Ethernet cable to the breakout, which splits the signal to the R145 Ethernet port and the SAE power
port.

Getting Acquainted P/N: 1011907-01 4



Antenna Connectors

Figure 2 shows the antenna connectors for the MR-2. The primary antenna connector is used to connect a GNSS
antenna for precise RTK positioning. You can connect another GNSS antenna to the secondary connector for

heading and inclination determination. For more information, see “Step 4: Connect Dual Antennas (HD2)" on

page 14.

For complete MR-2 operation, the external antenna supports at least GPS L1C/A, L2C, L2P (Y), GLONASS L1/L2,
and SBAS (WASS/MSAS/EGNOS) signal tracking and accept voltage at +4.75 to +5.10 VDC at 0-70 mA.

Topcon guarantees performance specifications of the MR-2 only when used with Topcon antennas, such as PG-

F1 GNSS antennas.
§
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Serial (Power)
(Power)T \
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==
Secondary
Antenna

Figure 2: MR-2 Interface
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Option Authorization File (OAF)

Topcon Positioning Systems issues an Option Authorization File (OAF) to enable the specific options that
customers purchase. An Option Authorization File allows customers to customize and configure the receiver
according to particular needs, thus only purchasing those options needed.

Typically, all receivers ship with a temporary OAF that allows it to be used for a predetermined period of time.
When the receiver is purchased, a new OAF permanently activates the desired, purchased options. Receiver
options remain intact when clearing the NVRAM or resetting the receiver.
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The OAF enables the following kinds of functions:

¢ Signal tracking (standard L1 GPS; optional L2, signal tracking)

* Update rate (standard 1Hz; optional 5, 10, 20, 50, or 100 Hz)

e RTKat1,5, 10, 20, 50, and 100 Hz

¢ RTCM/CMR Input/Output

* 2-D attitude determination

¢ Advanced multipath reduction

¢ Satellite Based Augmentation System positioning (WAAS/EGNOS/MSAS)
® RS-232C (2x) connectivity

~ Visit the TPS website (or consult a TPS dealer) for a complete list of available OAF options, details,
= and upgrades.

Twin Antenna System (HD2)

The MR-2 receiver includes a twin antenna system called HD2. It derives 2D attitude parameters, namely the
heading and inclination, of the baseline between two antennas mounted on a platform. For more information,
see “Twin Antenna System for Heading and Inclination Determination (HD2)"” of the

B125 Integrator’s Guide.

Option Authorization File (OAF) P/N: 1011907-01 6




Cables and Accessories

Standard Cables

The MR-2 package includes a cable harness that breaks out two serial communication ports and a power supply
connection to the receiver. Table 1 lists these cables.

Table 1. MR-2 Package Cables
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Cable Description Cable Illustration

Cable Harness

¢ Deutsch 3-pin connector: Connects the
receiver to a 9-36 VDC power supply.

¢ DB-9 connectors: Connects the receiver to
external devices (controller or computer)
for data transfer and receiver
configuration.

e BNC connector: Provides accurate time
transfer to external devices.

p/n: 14-008207-02LF

Power Adapter

Converts the Deutsch 3-pin connector to an
SAE connector for connection to a 9-36 VDC
power supply.

p/n 1000231-01

Ethernet Cable

¢ SAE connector: Connects the receiver to a
9-36 VDC power supply.

o Ethernet connector: Connects the receiver
to external devices (controller or
computer) for data transfer and receiver
configuration.

e M12 connector: Connects to the M12
connector on the receiver.

p/n: 1008816-01

10D
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Receiver Accessories

The MR-2 has a variety of accessories to increase its ease of use and facilitate installation. Table 2 lists these
accessories. For more details on the optional accessories available for the MR-2, contact a local Topcon dealer.

Table 2. MR-2 Package Cables

Cable Description Cable Illustration

Cable, Power/Charger

Connects the power supply unit to a
grounded outlet.

p/n 14-008052-01 (US)
p/n 14-008053-01 (AUS)
p/n 14-008054-01 (EUR)
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Power Supply Unit

Converts the alternating current (AC)
supplied from an electrical outlet to a direct
current (DC) for powering the receiver.

The unit connects to the receiver via the
power adapter cable.

p/n 22-034101-01

Full Wave Antenna

For optimal performance, the MR-2 should be
paired with a high precision Topcon GNSS
antenna. The PG-F1 offers high performance O

signal tracking for full constellation operation, yd A
while the PG-S1 may be used for dual — N 7

frequency configurations. w

Cable, External Antenna

Connects the external antenna to the
receiver,

Cables and Accessories P/N: 1011907-01 8




Mounting the Receiver

The four mounting flanges on the MR-2 housing enable you to easily secure the receiver in any orientation, onto
any hard surface, with the strength to withstand tough environmental conditions (Figure 3).

152 i
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Mounting the Receiver

Figure 3: MR-2 Mounting Dimensions
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LED Indicators

The LED indicators able you to control receiver power and data recording. The LEDs display the status of the
power, Ethernet connectivity, and satellite tracking. This chapter describes the different LED blink patterns and
what they mean.

STAT STAT
Power Ethernet (Primary Antenna) (Secondary Antenna)

RS

Figure 4: LED Indicators

]

Receiver Status LEDs

There are four status LEDs to provide you information about power Ethernet connectivity, and tracked satellites.
This section describes the color and behavior of each LED.

Power LED

The Power LED indicates whether the receiver is on or off, and to indicate the status and type of OAF loaded.
Table 3. Power LED Patterns

LED Color Description

- When the LED is off, the receiver is off.

When the LED is blinking or solid, the receiver is
on and an OAF is loaded. See below for the types
of OAF.

When the LED continuously blinks between red,
green and yellow, a standalone positioning OAF is
loaded.

When the LED is solid green, an RTK-enabled OAF
is loaded.

0000
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Ethernet LED m
O
The Ethernet LED indicates the status of the Ethernet connection. 5
Table 4. Ethernet LED Patterns 9.
Display Description S,.
- - ; (0]
P Solid Red: No Ethernet connection. =
s Solid Green: Ethernet Connection

established.

Satellite Tracking (STAT) LED

There are two LEDs to indicate the status of satellite tracking. If your receiver has only one B125 board, only
the STAT LED for the primary antenna will operate (Figure 4 on page 10). If your receiver has a second B125
board will both STAT LEDs operate. The number of blinks the LED makes indicates the number of satellites for
that constellation. Table 5 describes the blink patterns.

Table 5. STAT LED

Blink Order Definition

[y

Green blink per tracked GPS satellite

Dark once

Yellow blink per tracked GLONASS satellite

Dark once

Cyan blink per tracked Galileo satellite

Dark once

Magenta blink per tracked Compass satellite

Dark once

OO N UL DM W | N

Blue blink for each QZSS satellite

—
o

¢ One red blink: Receiver is not tracking satellites or does
not have a valid position solution

¢ Dark: Receiver has a valid position solution

Receiver Status LEDs P/N: 1011907-01




System Setup

Before using the MR-2, you will need to connect the necessary cables and antenna(s), and install the Topcon
software, which enables you to configure the receiver. This chapter describes how to set up your new receiver.

Cable and Antenna Connections

The MR-2 receiver is designed to use either a serial cable or Ethernet cable for full operation. The cable and
antenna setup for serial and Ethernet is described below.

Serial Cable Setup

Step 1: Power the Receiver

You can apply power to both ports at the same time. The receiver draws power from the port with the higher
voltage. If both voltages are the same, power will passively switch between both ports. The switching happens
within operating range, and causes no drop in power. The receiver will work without interruption.

1. Mount the receiver to a suitable hard surface where the LED is visible and the ports are accessible. See also
“Mounting the Receiver” on page 9.

2. Connect the supplied serial cable harness to the power/communication port (Figure 5).

Figure 5: Connecting the Serial Cable Harness to the Receiver

3. Connect the adapter cable to the power connector of the cable harness, as shown in Figure 6.

Cable Harness/Power Connector

Power Adapter Cable

Figure 6: Power Adapter Cable to the Power Connector
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4. Connect the other end (SAE connector) of the power adapter cable to a 9-36 VDC power supply unit with
an SAE connector, as shown in Figure 7.

Power Adapter Cable

Figure 7: Power Adapter Cable to Power Supply Unit

You can also create a custom cable to connect a 9-36 VDC directly to the 3-pin Deutsch connector on
=~ the break-out harness.

5. Verify the power supply is on and supplying power.
6. Make sure the MR-2 LED is lit solid, which indicates it is receiving power.

Step 2: Connect to a Computer or Display Unit and RTK Correction Source

1. Connect the COM1 serial port connector on the cable harness to the serial port on the computer or display.
2. (Optional) If the MR-2 is RTK enabled, connect the COM2 serial port connector to the serial port of the RTK

correction source.
@E COM2

@Eﬁ ) —— comi
\ A 3, — PWR

CCCO W 1PPS
Figure 8: Cable Harness — COM1 and COM2 Serial Ports

Step 3: Connect a Single Antenna

To connect a single external antenna for precise positioning:

1. Mount the GNSS antenna on a rigid surface.
2. Connect the antenna cable to the primary antenna connector circled in red in Figure 9.

Figure 9: Primary Antenna Connector

3. Make sure the antenna cable is connected to the antenna.
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Step 4: Connect Dual Antennas (HD2)

,@S HD2 Heading Determination (OCTO) OAF options must be enabled, in addition to a minimum of GPS
~ . .
</> L1/L2 signal tracking.

1. Mount both antennas on a rigid platform. The recommended antenna orientation is parallel to the direction
of travel; however, you can use any azimuth.

2. Connect the primary antenna cable to the rear antenna and to the primary antenna connector (Figure 10)
of the MR-2.

Primary Antenna

Secondary Antenna

Figure 10: Antenna Connectors

3. Connect the secondary antenna cable to the front antenna and the secondary antenna connector of the
MR-2.

4. Enable HD2 moving base corrections at the primary antenna, and HD2 heading determination at the
secondary antenna. See the B125 Integrator’s Guide for more information.

Step 5: Connect to a PPS Signal

1. Connect the PPS connector on the cable harness to a PPS input port of a suitable instrument.
2. Configure the PPS output with GRIL commands. To do this, see the B125 Integrator’s Guide.
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Ethernet Cable Setup

Step 1: Power the Receiver

1. Mount the receiver to a suitable hard surface where the LED is visible and the ports are accessible
(see “"Mounting the Receiver” on page 9).

2. Connect the adapter cable to the power connector of the cable harness, as shown in Figure 11.

Cable Harness/Power Connector

Power Adapter Cable

Figure 11: Power Adapter Cable to the Power Connector

3. Connect the other end (SAE connector) of the power adapter cable to a 9-36 VDC power supply unit with
an SAE connector, as shown in Figure 12.

Power Adapter Cable

Figure 12: Power Adapter Cable to Power Supply Unit

~ You can also create a custom cable to connect a 9-36 VDC directly to the 3-pin Deutsch connector on
2 the break-out harness.

4. Verify the power supply is on and supplying power.
5. Make sure the MR-2 LED is lit solid, which indicates it is receiving power.
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Step 2: Connect the Ethernet Cable

The MR-2 allows up to five virtual TCP port connections using the same IP address. Virtual TCP ports can be
used to connect the device to a PC (for control) and to an RTK source. Figure 13 shows the connections for the
Ethernet cable.

Connect to Power

Connect to MR-2

-

| —]

Connect to Source

Figure 13: Ethernet Cable Connections

1. Connect the Ethernet cable to the MR-2.
2. Connect the RJ45 end of the Ethernet cable to a source.
3. Connect the SAE end of the Ethernet cable to a power source.

Step 3: Connect a Single Antenna

To connect a single external antenna for precise positioning:

1. Mount the GNSS antenna on a rigid surface.
2. Connect the antenna cable to the primary antenna connector circled in red in Figure 14.

Q/0/0/0/0[0

Q/0/0/0/0[0

A —
[\ P

Figure 14: Primary Antenna Connector

3. Make sure the antenna cable is connected to the antenna.

Cable and Antenna Connections P/N: 1011907-01
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Step 4: Connect Dual Antennas (HD2)

,@S HD2 Heading Determination (OCTO) OAF options must be enabled, in addition to a minimum of GPS
~ . .
</> L1/L2 signal tracking.

1. Mount both antennas on a rigid platform. The recommended antenna orientation is parallel to the direction
of travel; however, you can use any azimuth.

2. Connect the primary antenna cable to the rear antenna and to the primary antenna connector (Figure 15)
of the MR-2.

Primary Antenna

Secondary Antenna

Figure 15: Antenna Connectors

3. Connect the secondary antenna cable to the front antenna and the secondary antenna connector of the
MR-2.

4. Enable HD2 moving base corrections at the primary antenna, and HD2 heading determination at the
secondary antenna. See the B125 Integrator’s Guide for more information.

Step 5: Connect to a PPS Signal

1. Connect the PPS connector on the cable harness to a PPS input port of a suitable instrument.
2. Configure the PPS output with GRIL commands. To do this, see the B125 Integrator’s Guide.
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Install the Topcon Receiver Utility (TRU)

TRU is Topcon’s GNSS receiver configuration software. You can download the software from Topcon’s myTopcon

Website (https://www.topconpositioning.com/support). For more information on any of the procedures in this
section or on TRU, refer to the 7RU Online Help embedded in the software.

Computer requirements for TRU are: Microsoft® Windows XP/Vista/7 operating system, an RS-232C port, or an

Ethernet port. Mobile editions are also available for Topcon supported devices equipped with serial connections
running WinCE 5, WinCE 6, WinMobile 6.1/6.5/6.5.3.

To install and run TRU on a computer:

1. Visit myTopcon (https://www.topconpositioning.com/support) and download the file.

2. Locate the TRU.exe file on your computer, and double-click the file to run the installation wizard.

3. Following the on-screen instructions. After installing, a TRU shortcut appears on your desktop.

4. To start TRU, double-click the shortcut, or select it from the Start menu. The TRU main screen appears

(Figure 16).
W Topcon Receiver Utility ﬂ J g &
Device View Help
i — [ o . Bk
S =, T % g
Terminal Information  Options Tools Receiv.er Statlus File Explorer
_ Settings
E L
Modem
Driver
ﬁ Receiver Managing Mode @
Figure 16: TRU — Main Screen
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Managing Power

This chapter describes how to power the receiver and use an external power source.

Turning the Receiver On/Off

@ Use a 5A fuse if connecting directly to a vehicle DC power source.

1. To turn on the receiver, connect either a serial or Ethernet cable from the unit to a power source.
2. To turn off the receiver, disconnect either the serial or Ethernet cable from the unit.

Once the cable is disconnected, the receiver will begin an internal shutdown process lasting approximately 1 to

1.5 minutes. During this process, the receiver is not receiving power, but the power LED remains on until the
end of the shutdown process.

After shutdown, the receiver will begin the startup process lasting approximately 1 to 1.5 minutes. Some

receiver functions may be available during this process. All functions of the receiver are available when the
startup process completes.

Powering the Receiver

The receiver is powered by an external power source connected to either the serial connector or Ethernet
connector.

@ Power input greater than 36 VDC could damage the receiver.

Connect to an External Power Source

To power the receiver with an external power supply, connect the SAE connector to a power supply operating
between 9 and 36 volts.

Power Cycling

If power is removed from the receiver, it will take up to two minutes for a complete shutdown. When the receiver
is powered on, it will take approximately one minute for a full reboot.
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Configuration

Configuring the receiver enables you to change GPS settings, verify satellite tracking, etc. To do this, you'll need
to use the Topcon Receiver Utility (TRU) software available the myTopcon Website

(https://www.topconpositioning.com/support). See “Install the Topcon Receiver Utility (TRU)” on page 18 for
more information.

The sections in this chapter describe how to use TRU to configure the receiver. Once this is accomplished, you can:
* Set up GPS parameters and other settings

Monitor the receiver’s GPS status
* Log raw data to a file

Load a new OAF, firmware, and other configuration files to the receiver
Connect The Receiver to TRU

The steps in this section work with receivers that have one or two boards.
1.

Connect the receiver and computer as described in “Step 2: Connect to a Computer or Display Unit and RTK
Correction Source” on page 13.

2. Start TRU on the computer. The TRU main screen displays (Figure 17). Initially the tools are inactive.

ETupcun Receiver Utility _?I;lglll
" Device View Help
- — o ! " 2 R
AS=y T % Q
Terminal Information  Options Tools Receiver Status  File Explorer
. Settings
E -

Modem
Driver

| i Receiver Managing Mode

| @

Figure 17: TRU — Main Screen
3. Click Device » Application Mode » Receiver Managing.
4. Click Device » Connect. The Connection Parameters screen appears.
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5. Select Serial Port for the Connect Using drop-down list (Figure 18). @)
@)

Connect Using 09

c

|serial Port ~| =

=

Part Name (@]

Communications Port (COM1) E] -]

Figure 18: TRU — Connection Parameters

6. Click the Browse button .. |to the right of Port Name.
7. Choose a port from the Select Port screen, and click OK (Figure 19). The Connection Parameters screen
appears.

SiselecitPor 7| ok _ | O] X

Friendly Mame Physical Ma

| Communications Port (COM1) ‘\.\COM1

«| 1 |

- d

Figure 19: TRU — Select Port Screen

The Port Name shows the friendly and physical name of the computer port. The application remembers the
last used transport, and the last used successful port/device name for every transport, making it easy to connect
to the same device.
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8. If using a secondary receiver board, select the Secondary Receiver check box, and select Serial C from
the Receiver Port drop-down list (Figure 18 on page 21).

9. Click Connect to establish a connection.

Once the receiver connects to TRU, the icons on the main screen become active. Once active, you can configure
the receiver.

Ethernet Connection

This section describes how to customize the Ethernet settings in the receiver, and how to connect to the receiver
with TRU using an Ethernet connection.

Receiver Ethernet Settings

To verify Ethernet connectivity, the receiver must be connected to an external network or laptop. For a laptop
connection, set up a static IP address on the computer.

Once connected, the Ethernet LED will be solid 2-5 seconds after the receiver is powered on, indicating that an
Ethernet connection is established. If the Ethernet LED does not become green after 10 seconds, check the
external network connect, or reboot the receiver.

View Receiver IP Addresses

The receiver contains a main and auxiliary GNSS board. The IP address for the main board is 192.168.0.9 and
the IP address for the auxiliary board is 192.168.0.10.

To view the IP address of each board, do the following.

1. Connect the receiver to TRU using a Serial connection. See “Connect The Receiver to TRU” on page 20.

2. In TRU, click Receiver Settings » Network. The Network screen appears and the Ethernet tab is
active (Figure 20).

5 Nomwor RN

Ethemet \WiFi | TCP | TCP Client| HTTP | FTP |

IP Setup: 'Static 1P )
IP Address: 192 . 168 . 0 . 9

IP Mask: 255 . 255 . 255 . 0

Gateway: 192 168 . 0 . 1 |
DNS: g8 .8 .8 .8 |
Host Name:

Figure 20: TRU — Network Screen

3. Write down the IP Address and Gateway.
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Set Up a Static IP Address For the Laptop

When setting up the static IP address of the laptop, the first three numbers of the IP address must match the
receiver’s IP address. For example, if the receiver’s IP address is 10.5.57.200, the computer IP address must be
10.5.57.xxx.

1. Open the Network and Sharing Center on your laptop.

2. Change your Local Area Connection TCP/IPv4 settings to match the receiver (Figure 21).

Q
©)
)
=
09
c
=
Q
=
o
)

F ™
Internet Protocel Version 4 (TCP/IPvd) Properties m

General

You can get IP settings assigned automatically if your network supparts
this capability. Otherwise, you need to ask your network administrator
for the appropriate IP settings.

() Obtain an IP address automatically

i@ Uge the following IP address:;

IP address: 192 . 168 . 0 . 15
Subnet mask: 255,255,255 . 0
Default gateway:

Obtain DNS server address automatically
(@) Use the following DNS server addresses:

Preferred DNS server:

Alternate DNS server:

I [7] validate settings upon exit
|l
t [ ok || cencel |

Figure 21: Laptop Internet Protocol Settings

3. Enter the IP address for the primary board (see “View Receiver IP Addresses” on page 22).
4. If needed, enter the Default gateway address.
5. Click OK to apply the changes to your laptop.
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View Receiver Password Q
1. Connect the receiver to TRU using a Serial connection (see “Connect The Receiver to TRU” on page 20). 3
2. Click Receiver Settings » Network. The Network screen appears (Figure 22). og
=
F N m
5 Network EEMEE =
| Ethernet | Wi-Fi | TCP | TCP Client| HTTP | FTP | =)
Timeout, s:
il Password: topcon

Figure 22: Network — TCP Tab

3. Click the TCP tab. The password displays in the Password field.

Change Password

1. Connect the receiver to TRU using a Serial connection (see “Connect The Receiver to TRU" on page 20).
2. Click Receiver Settings » Network. The Network screen appears (Figure 22).

3. Click the TCP tab, and enter a new password in the Password field.

4. Click OK, and reset the receiver to enable the new password.

@g For all receivers, the default password is topcon.

Reset the Receiver

After changing Ethernet settings, reset the receiver. Open the Terminal window, enter set, reset, yes and click
Send. The IP addresses become assigned within 30 seconds after reset. The Receiver will reply with a ping,
and become accessible by TCP ports from TRU or PC-CDU. Click X to close Terminal and go to the TRU main
screen.

Shutdown of the receiver takes approximately 1 to 1.5 minutes. After shutdown, the receiver takes
approximately 1 to 1.5 minutes to restart. After restart, all functions of the receiver are available.
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Connect to TRU Using Ethernet

1. Start TRU on the computer. The TRU main screen displays (Figure 17 on page 20). Initially the tools are
inactive.

2. Click Device » Application Mode » Receiver Managing.
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3. Click Device » Connect. The Connection Parameters screen appears.
4. Select Network from the Connect Using drop-down list (Figure 23).
Connect Using
lNetwork vl
Port Name
TCP1 (192, 168.0,2:80032) B
Receiver Port

[ Secondary Receiver
Serial A

Figure 23: TRU Connection Parameters — Network
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5. If needed, click the Browse icon - to the right of Port Name to choose a port from the My Network
Devices screen, and click OK (Figure 24). The Connection Parameters screen appears.

Wy Network De._. 7] o _| O x|

Friendly Mame  IP Address or Host Mame T

F

Q
©)
)
=
09
c
=
Q
=
o
)

192.168.0.9

aq | 1 | b
e ¥ |
Figure 24: My Network Devices — Ethernet Device

The Port Name shows the friendly and physical names of the computer port. The application remembers the
last used transport, and the last used successful port/device name for every transport, making it easy to connect
to the same device.

6. If needed, right-click on the desired port and click Edit. The Network Connection Parameters screen
appears (Figure 25).

8 Network Comne... 7] o _| 0] x|

Friendly Mame

[TCFP1

IF Address or Host Mame

192,165.0.9

TCP Port

g002

Password

topcon

[

Figure 25: Network Connection Parameters

7. Enter the IP address and password of the GNSS receiver you want to connect to. The main board IP
address is 192.168.0.9, and the auxiliary board IP address is 192.168.0.10.

8. Enter 8002 as the default for TCP Port, and click OK. The Connection Parameters screen appears.
9. Click Connect to connect to the receiver.
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Configure the Receiver

The following base and rover configurations are recommended for the most common applications; however, you
can select configuration parameters as needed.

@ Do not make other changes without consulting the 7RU Online Help, embedded in the software.

Configure the Receiver as a Base
The following describes how to configure the receiver as a base.

Configure the Antenna

1. In TRU, click Device » Application Mode » Receiver Managing » Receiver Settings. The Receiver
Settings screen appears (Figure 26).

' Device View Help

&% 4jiFi Q&

Ports Bluetooth Network

| i Receiver Managing Mode |f_ 10.1.30.78 |@ v

Figure 26: TRU — Receiver Settings

2. Click Tracking & Positioning. The Tracking & Positioning screen appears (Figure 27 on page 28).
3. Click the Antenna tab, and set the GNSS Antenna type to External.

Configure the Receiver P/N: 1011907-01

Q
©)
)
=
09
c
=
Q
=
o
)




Q]
[~ i a - T - g
Tracking & Positionin ?lo X
.  Tracking & Posivonng 2lod_Jolx| [
Antenna | Obs | Positioning | Base |RTK |HD2 |Adv | c
=
GNSS Antenna =
| > Current Input: ~
. Internal g
Tracking & © Extornal Eutemal
Positioning
Auto

s

Figure 27: Set Antenna Usage

4. Click the Obs tab, and set the following parameters (Figure 28):
¢ Elevation Mask, deg: Set Satellites Tracking to 5 degrees.
* Elevation Mask, deg: Set Position Computation to 13 degrees.
* PDOP Mask: Set Position Computation to 30 degrees.

3

- Y = T i N
!ﬁ] Tracking & Positioning _?l ﬂ ;l El EI
Antenna | Obs | Positioning | Base | RTK | HD2 | Adv |
Elevation Mask, deg

Satellites Tracking: E

Position Computation: 13

RTK Computation: 10

PDOP Mask
Paosition Computation:

30

RTK Computation:
35

.

Figure 28: Configure Receiver Positioning — Elevation Mask
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5. Click the Adv tab, and set the following parameters (Figure 29):
® Select the C/A code multipath reduction check box. This reduces the C/A code phase multipath.
* Select the C/A carrier phase multipath reduction check box. This reduces the C/A carrier phase multipath.

* Ensure that the Cinderella check box is unselected. Only select this option if you want to set all of the receiver
options to their maximum allowable values for 24 hours every other Tuesday at GPS midnight.
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- Y ¥ 9 N
\ 'ﬁi Tracking & Positioning ﬂ ﬂ J gl &
| Antenna | Obs | Positioning | Base |RTK |HD2 | Adv

Raw measurement update rate, ms:

Position update rate, ms:
100

C/A code multipath reduction

C/A carrier phase multipath reduction
[|Cinderella

[ ] Quartz Lock Loop

Anti-jamming

Figure 29: Configure Advanced Parameters

6. Click OK to return to the Receiver Settings screen.

7. Configure the reference coordinates by entering them using GRIL commands (see “Commands” of the
GRIL Reference Guide).

You can also set the reference coordinates using the Base tab in TRU (Figure 30).

%4, Tracking & Positioning o _ | O] x|

Arenra | Obs | Postioning | Bes=  |RTK | HDZ |aAav | ||| o o ' o
Antenna Type ) ﬂ D

1 Ll > ' "
TPaGRS MNOME - Lo c c E]

Alt a m
L| Base Station Coordinates il

@ Antenna Reference Pont -
| [ Get from the receiver

0000'0. DO000D"N; CO°00'0, 000000"E; 0.0000m III

I Fhase Center L1
00°00'0, 00001L3"N; 00000, 000042 ; 0, 2213m

Detert Ionospheric Sqntilations

Auto 5eed

Figure 30: Set Reference Coordinates in the Base Tab
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Set Up the Receiver Serial Ports

1. InTRU, click Device » Application Mode » Receiver Managing » Receiver Settings. The Receiver
Settings screen appears (Figure 31).

' Device View Help
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€. X" x.
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Back Satellites | Ports Bluetooth  Metwork
| i Receiver Managing Mode |i':_ 10.1.30.78 |@ v

Figure 31: TRU — Receiver Settings

2. Click Ports. The Receiver Ports screen appears (Figure 32 on page 30).
3. Double-click the appropriate Serial Port name (Figure 33 on page 31). The Settings screen for that port

appears.
F F a - T N 5
"” Receiver Ports ﬂJgﬂ
C :
—— Serial |USB | TCP | Bluetooth | Nrrip |
! e MName Input Output Baud Rate RTS/CTS
— .
i §,4Serial A Command 115200  Of
Forts BSerialB Command 115200 Off

f_¥SerialC Command nmea 115200  Of

s -

Figure 32: TRU — Receiver Ports

4. In the Settings screen, select the following (Figure 33):
¢ Input Mode - Select Command
* Output Mode — Select RTK RTCM 3.1
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Elev. Mask, deg: 5
Period, s: 1

Messages ]

Figure 33: TRU — Serial Port Settings

5. Click OK to return to the Receiver Ports screen.

If you want to set up additional messages, follow the process below. Otherwise click X to return to the Receiver
Settings screen, then click Back to return to the TRU main screen.

Set Up The Receiver TCP Port

1. InTRU, click Device » Application Mode » Receiver Managing » Receiver Settings. The Receiver
Settings screen appears (Figure 34).

' Device View Help

4 = s ——
& & o A
| L -
Back Satellites  {Tracking & Ports Bluetooth Network
| i Receiver Managing Mode |f_ 10.1.30.78 |@ v

Figure 34: TRU — Receiver Settings

2. Click Ports, then click the TCP tab. The Receiver Ports screen for the TCP tab appears (Figure 35).
3. Double-click the appropriate TCP Port name (Figure 35). The Settings screen for that port appears.
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Figure 35: TRU — Receiver TCP Port

4. In the Settings screen, select the following (Figure 36):
¢ Input Mode - Select Command
¢ Output Mode - Select RTK RTCM 3.1

£ TCP A Setiings 2od _ Ol X]

Input Mode: ’Command ']
Output Mode: [RTKRTCM 3.1 |
Elev. Mask, deqg: -q0
Period, s: 1

Messages ]

Figure 36: TRU — TCP Port Settings
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5. Click OK to return to the Receiver Ports screen.

@g Disabling authentication or changing the port number is done in the TCP tab.
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6. If you want to set up additional messages, follow the process below. Otherwise click X to return to the
Receiver Settings screen, then click Back to return to the TRU main screen.

Set Up Additional Messages (Optional)

1. In the Settings screen for your selected serial port, click Messages. The Messages screen appears
(Figure 37 on page 33).

L =
Messages  ?jox_ |0 X|
Message Per... | P... | C... | F... | Det
= rtcm3/1004  1.00 0.00 0 0Ox0 GF
= rtcm3/1012  1.00 0.00 0 0Ox0 GLC
= rtcm3/1006 10.00 0.00 0 0Ox0 Sta

| = rtcm3/1008 10.00 0.00 0 0Ox0 Ant
= rtcm3/4091t 10.00 0.00 0 Ox0 TP
= rtem3/1033 10.00 0.00 0 0Ox0 Ret
4 I F

(= -

Figure 37: TRU — Serial Port Messages

2. Right-click in the screen and click Add new messages. The Receiver Message List screen appears
(Figure 38 on page 34).
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Figure 38: Add New Serial Port Messages

3. Click the (+) icon to expand the rtem3 list, and select a message you want to add (Figure 39).
4. Double-click the message to add it. The message appears in the bottom list panel. (Figure 39).
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= 1007 (Antenna Descriptor)
------ = 1008 (Antenna Descriptor & Serial Number)
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1005 (Stationary Antenna Reference Point, No Height I
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Figure 39: New Serial Port Message Added

If you want to edit the new message, follow the procedure below. Otherwise, Click OK to return to the Settings
screen. Click OK again to return to the Receiver Ports screen, and Click X to return to the Receiver Settings
screen. Finally, click Back to return to the TRU main screen.
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Edit Additional Messages (Optional) 9
1. Right-click on the new message from the bottom list panel of the Receiver Message List screen. Eh
2. Click Edit message. The Receiver Message screen appears (Figure 40). 09
c
=
Q
3 . =
R_LBl:BiVEf Message List 3' ﬂ ;l Q il Receiver Message _?l ﬂ ;l gl ﬁl g
B~ = rtem3 e Message
------ = 1003 (GPS Basic RTK, L1 & L2) |? -
______ — 1004 (GPS Extended RTK, L1 & L2) B rtcm3/1003 (GPS Basic RTK, L1 & L2)
------ = 1005 (Stationary Antenna Reference Point, No Height I
[ = 1006 (Stationary Antenna Reference Point, with Height Schedule Specification
------ = 1007 (Antenna Descriptar) Period, s: []
L = 1008 (Antenna Descriptor & Serial Mumber)
------ = 1011 (GLONASS Basic RTK, L1 & L2) Fhase, s: g
------ = 1012 (GLONASS Extended RTK, L1 & L2}
...... = 1010 froC anhamariad N Count: D
< | I | 3
Flags:
I\jessage Period Phase Coun Is Descript... I:‘ Out I:‘ Fix Per
- [ | change []FixpPh
Delete messages []out on Add [ Fix cnt
Delete all messages D ST D Fix Fl
Cut
Paste
F—— [ ] — b

Figure 40: Edit a New Message

3. Edit the information as needed, and click OK. The Receiver Message List screen appears.
4. Click OK to return to the Messages screen, then click OK again to return to the Settings screen.
5. In the Settings screen, click OK to return to the Receiver Ports screen, then click X to return to the

Receiver Settings screen.
6. Click Back to return to the TRU main screen.

Configure the Receiver as a Rover

The following describes how to configure the receiver as a rover.

Set the Receiver Positioning

1. Follow steps 1-6 in “Configure the Antenna” on page 27.

2. In the Receiver Settings screen, click Tracking & Positioning. The Tracking & Positioning screen
appears

3. Click the Positioning tab (Figure 41 on page 36).
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- T T
‘ﬁs Tracking & Positioning _?lﬂ;lglll
Antenna | Obs | Positioning | Base | RTK |HD2 | Adv |

Paositioning Mode CIOM

(@) Standalone @) off

-;- DGMNSS @ Local
[ VRTK Float -

(") RTK Fixed () Smooth

Enable Solutions
Standalone
[ |DGNSS
RTK Float
RTK Fixed

Figure 41: Receiver Settings — Positioning

4. Set the following parameters then click OK to return to the Receiver Settings screen.
* Positioning Mode — Select a positioning mode for the receiver.
* Enable Solutions — Select solutions used in position computation.
— Standalone — Where the receiver computes 3D coordinates in autonomous mode without using
differential correction.
— Code Differential — Where the rover receiver computes the current relative coordinate in differential
mode using only pseudo ranges.

— RTK Float — Where the Rover receiver computes the current relative coordinates in differential mode
using both pseudo ranges and phases; however, with a float solution, the phase ambiguity is not a
fixed integer number and the “float” estimate is used instead.

— RTK Fixed — Where the rover receiver computes current relative coordinates, with ambiguity fixing, in
differential mode.
* DION - Select the mode in which the DION engine will operate.
— Off — The DION engine is disabled.
— Local — The DION engine provides precise positioning with respect to a starting point.

— Smooth — The DION engine provides smoothed estimates of absolute positions using refined delta
positions from carrier phase processing.

5. Click OK to return to the Receiver Settings screen.

Configure the Receiver P/N: 1011907-01
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Set Up the Receiver Serial Ports Q
1. In the Receiver Settings screen, click Ports (Figure 42). The Receiver Ports screen appears. ?h
&
= F— - F = - h E
(S = 1=Recei|rerPnrls _?l;lglil g-
= 1l - - @)
Serial |USB | TCP | Bluetooth | Ntrip | -

I E— Name Input Output BaudRate RTS/CTS

Paorts f_1Serial A Command 115200  Of

f_1Serial B Command 115200  Of
{_iSerialC Command nmea 115200  Off

S o

Figure 42: Receiver Settings

2. Double-click the appropriate Serial Port name (Figure 42). The Settings screen for that port appears.
3. In the Settings screen, select the following (Figure 43):

¢ Input Mode — Select RTCM 3.x

* Output Mode — None

Serial A Seftings T I 2o _ | O] X|
General | Serial

Input Mode: [RTCM:‘LX v]

Output Mode: [Ngne v]

Messages ]

Figure 43: Serial Port Settings

4. Click OK to return to the Receiver Ports screen, then click X to return to the Receiver Settings screen.
5. Click Back to return to the TRU main screen.
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Set Up The Receiver TCP Port

1. In the Receiver Settings screen, click Ports then click the TCP tab (Figure 44). The Receiver Ports
screen for the TCP tab appears.
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= s -':HeceiverPurls _?IJE&

N | Serial |USB | TCP | Bluetooth | Nirip |
| ': — > Name Input Output
Ports E"TCF’A Command |ps

L¥ TCPB Command
L¥ TCPC Command
L¥ TCPD Command
L¥ TCPE Command

[ r

Figure 44: Receiver Settings

2. Double-click the appropriate TCP Port name (Figure 45). The Settings screen for that port appears.
3. In the Settings screen, select the following (Figure 45):

¢ Input Mode — Select RTCM 3.x

* Output Mode — None

4/ TCP A Settings 2Jod _|Of x|

Input Mode: [RTCM.’%){ ']

Output Mode: [None "]

Messages ]

Figure 45: Serial Port Settings
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4. Click OK to return to the Receiver Ports screen, then click X to return to the Receiver Settings screen.
5. Click Back to return to the TRU main screen.

Once the receiver is configured, the configuration remains until changed using TRU or by clearing the NVRAM.

For more details on the settings available for configuring receivers, see the 7RU Online Help embedded in the
software.

uoneindyuod

Verify Receipt of Differential Corrections (RTK Rover Only)

1. For RTK Rover receivers, click Status (Figure 46) to ensure the receiver obtains differential correction. The
Status screen appears.

5 Status MR-2 MASTER ID-009FDBZAOLK

i { Postion }| Data Link | SV List | Sky Plot | Scatter [ Posttion In Time | Logging |
J.‘ } WGS-24

o |

=l

10/28f2015 6:39:51 PM

%)  RTK Fixed
—>
la:  51° 7' 4.8942" N
Status lon: 114" 2' 20.4864" W
Avm 1052539 g g0
‘35 &0

PDOP: 1.760 "D o0
HRMS, m: 0.017 1 @0

VRMS, m: 0.027 g @
Base Dist.km: 12.476 &0 @0

Figure 46: TRU — Main Screen and Status Screen
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The Data Link tab reflects the status of the received differential messages. If the port is not configured or if
the corrections are not being received, the Link Quality field will be empty.

— |
% Status MR-2 MASTER ID:009FDBZAOLK (2]
| Position |DEItEI|-Iﬂk| SV List | Sky Plot I Scatter | Position In Time | Logging|
Data Link 1

Data Link Identifier serfb

Decoder RTCHM 3.0

Ref Station 0040

Link Quality 100%

DLink Delay 0

|| Received Messages 26
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Corrupt Messages 0

Figure 47: Status — Data Link

2. When finished, click X to close the Status screen and return to the TRU main screen.
3. Click Device » Disconnect, then Device » Exit to close TRU.

@g Disconnecting before exiting TRU ensures proper port management.
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Configure Receiver for HD2 Operation

HD2 Overview

uoneindyuod

,@ HD2 Heading Determination (OCTO) OAF options must be enabled, in addition to a minimum of GPS
~ . .
</> L1/L2 signal tracking.

The MR-2 can process accurate and instantaneous attitude parameters. The MR-2 combines a pair of B125
receiver boards, and two external antennas, to create a 2D system for heading and pitch. With this method,
one board acts as a moving base, and the other as a rover. The antennas are fixed, and the inter-antenna
distance is constant. The moving base sends standalone position and raw data to the rover, which processes
the data and sends them using ASCII or binary messages.

You can also configure the moving base to accept RTK measurements from a stationary base station. With this
method, the moving base is used as a base and a rover simultaneously. The moving base will process its
position, with centimeter level accuracy, using the measurements from the stationary base station. It will then
transmit the position to the rover.

HD2 operation requires scripts that will configure the receiver by sending commands to the master board of the
MR-2. Several scripts are available on the Topcon Positioning Systems website, which cover the popular work
flows of the MR-2, and can be modified for custom applications.

1. Go to Attps.//www.topconpositioning.comy/support/products/mr-2, and click
Firmware & Software Updates (Figure 48).

#TDP'CO“ | n:-' el flngink) = & bird g Dasier | [egess Solto L

'|'.'I.'T|:. A ]

MR-2

B REGISTERED
“, (el
- . —
=

CUICK GLIDES

TRU [Topcon Bosoehner Lislity TRU (Topcon Bacehoar Litlityk
Viewing/Loading QiFs Upgrading GMNES Firmwarne

TRU (Topcon Beoohnsr
Litility): Sotup

Figure 48: MR-2 Product Page

2. Connect the primary receiver board to TRU. For more information about connecting to the receiver using
TRU, see “Connect The Receiver to TRU” on page 20.

3. Under Software, locate the scripts, click the Download icon, and save the scripts to your computer.
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4. Access the Terminal window, and send the script file to the master board by selecting the Send File
menu item.

<//\/§ Scripts are subject to change as firmware matures.

5. To access the heading determination output, connect to the secondary board in TRU, and access the
Status Heading screen. Alternatively, the VHD log can be output from the secondary board.

Check the Receiver’'s OAF

Use TRU to view the status of the receiver’s options.

1. Connect the receiver to a computer. See “Step 2: Connect to a Computer or Display Unit and RTK
Correction Source” on page 13
Open TRU and connect to the receiver. See “Connect The Receiver to TRU” on page 20.

Click the Options == icon in the main screen. The Receiver Options screen displays, so you can view
the current authorization options and upload new ones (Figure 49).

r ~
=" Receiver Options _?I ;I EI ll
Friendly Name Current Permanent Leased ol

Tracking
GPS L1, L2, L5 L1, L2, L5
GLDNASS L1, 12, L3 L1, 12, 13
Gameo El, ES5, E6 El, E5, E6
E]Beinnu B1, B2, B3 B1, B2, B3
[Elseas 11,15 11,15
QZSS L1, L2, LS, LEX Tracking, LEX Decoding L1, L2, L5, LEX Tracking, LEX Decoding E
Sate\l\te Tracking Channel Count 224 224 224
Dual Antenna Tracking Yes Yes Yes
Co—op Tracking Yes Yes Yes
Quar‘u Locked Loop Yes Yes Yes
Adaptlve PLL Yes Yes Yes
EMu\ripath Reduction Yes Yes Yes L
Raw Measurement Update Rate, Hz 100 100 100
Positioning
[Elocnss Mode Yes Yes Yes
RTK Positioning, Hz 100 100 100
RTK Vertical Accuracy Level, cm 0 0 999
RTK Horizontal Accuracy Level, cm 0 0 999
Mammal Baseline Length, km Mo restrictions Mo restrictions No restriction
EHDZ Mode Heading and Pitch Heading and Pitch Heading, Pitcl
D[DN Mode Yes Yes Yes
AutoSeed Mode Yes Yes Yes
DmniSTAR Service VBS, XP, HP, G2 VBS, XP, HP, G2 VBS, XP, HP,
Prec\se Positioning Mode Code, Float, Fixed, Veripos Code, Float, Fixed, Veripos
Inertia\ Integration Yes Yes Yes
Pusltlon Update Rate, Hz 100 100 100
Interfaces
EMemory, MB Mo Restrictions Mo Restrictions No Restrictior
lfPPS Timing Signal Double Double Double
Flinnt Martnee Cinnln Sinaln Rrkin
«| I | »

Figure 49: Receiver Options
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Load an OAF

Each B125 board requires an OAF file provided by Topcon dealers. For any OAF related questions, e-mail Topcon
at options@topcon.com and include the receiver’s ID and serial number. To obtain these numbers, see “Check
the Receiver’'s OAF” on page 42.

1. Follow the steps in “Check the Receiver's OAF” on page 42.

2. Right-click in the Receiver Options screen, and select Upload OAF (Figure 50).
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r ~
= Receiver Options _?I ;I gl EI
Friendly Name Current Permanent Leased o

Tracking B
GPS L1, 12, 15 11,12, 15
GLDNASS L1, L2, 13 11,12, L3
Gahlen El, ES5, E6 E1, ES, E6
Be\Dou B1, B2, B3 B1, B2, B3
[E]seas L, 15 1,15
QZSS L1, L2, L5, LEX Tracking, LEX Decoding L1, L2, L5, LEX Tracking, LEX Decoding =
Satelhte Tracking Channel Count 224 224 224
Dua\ Antenna Tracking Yes Yes Yes
Cornp Tracking Yes Yes Yes
Quarlz Locked Loop Yes Refresh Yes
[E]adaptive pLL Yes Upload OAF Yes
Multlpath Reduction Yes SavetoFile » Yes |
Raw Measurement Update Rate, Hz 100 View 4 100

Positioning

[Elpsnss mode Yes Yes Yes
RTK Positioning, Hz 100 100 100
RTK Vertical Accuracy Level, cm 1] 0 999
RTK Horizontal Accuracy Level, cm 0 0 999
Mawma\ Baseline Length, km No restrictions No restrictions Mo restriction
HDZ Mode Heading and Pitch Heading and Pitch Heading, Pitct
D]:DN Mode Yes Yes Yes
AutoSeed Mode Yes Yes Yes
UmmSTAR Service VBS, XP, HP, G2 VBS, XP, HP, G2 VBS, XP, HP,
Precwse Positioning Mode Code, Float, Fixed, Veripos Code, Float, Fixed, Veripos
Inemal Integration Yes Yes Yes
Fosmon Update Rate, Hz 100 100 100

Interfaces
Memury, MB No Restrictions No Restrictions Mo Restrictior
1-PPS Timing Signal Double Double Double
N NV Simnln Cinnin Pkl
< | [T | 3

Figure 50: Right-click and Select Upload OAF

3. Navigate to the location of the new Option Authorization File.
4. Select the appropriate file, and click Open (Figure 51).

rai)pen F
O@—Ii » MR-2 -|;, |7'_

Organize v New folder

. Favorites . Name Date modified Type

B Desktop | _UNIVERSAL Digest_12-14-2013.tpo 12/4/2013 1242 PM  TPO File
14 Downloads

f < Recent Places

m

=] Libraries
I, Documents
4. Music
5 Pictures
‘. Videos

& Computer L
| Bl 1 | 3

Ba meal Mk 700

File name: _UNIVERSAL Digest_12-14-2013.tpo

F—— — = —

Figure 51: Load OAF
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Topcon’s TRU initially checks to see if the selected file is compatible with the currently connected receiver. If
you chose a file not intended for this receiver, the Upload OAF window displays an error icon next to the
Receiver ID and disables the Upload the File to the Receiver button.

5. Click Upload the File to the Receiver to start loading the file (Figure 52).

5\_UNIVERSAL Digest_12-14-2013.tpoj i

Property Value sl
Eﬁwner -

Fserialio NA

[F]RreceiverD _UNIVERSAL_

E Model HKHXO0OCOEXK Universi
E Checksum 4739

| EDealer Topcon Positioning Syste
! EEmail IMullen@topcon.com
ESubmitTime 2013-12-04 20:40:18
E Cipher Digest

EComments Topcon Universal File
< | 1 | b

N Upload the File to the Receiver /],/>
— S

Figure 52: Upload the OAF to the Receiver
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6. Click Yes at the prompt to reset the receiver (Figure 53).

- -
e,

TRU | 22

e
0 The changes will take effect after reset, Reset the receiver?
b -

C= D

Figure 53: Reset Receiver

When the receiver resets, the Connection Parameters screen opens.
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7. Click Connect (Figure 54). The TRU main screen appears. @)
@)
L | :
@ Connection Para___ _'?I ;I g & O:Qh
Connect Using E
|Serial Port v | =
@)
o
Port Name

Communications Port (\\.\COM1) B

Figure 54: Connect to the Receiver

[

8. Click Options (Figure 55). The Receiver Options screen displays.

ETopmnReoei\rerUlilily _?I;lglll
" Device View Help
— — - -
pym—— g u,‘. e
AS=y T % Q
A &
Terminal Information  Options Tools Receiver Status  File Explorer
. Settings
%F’r
Modem
Driver
|‘ Receiver Managing Mode | a Y

Figure 55: Click Options
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9.

10. To view additional OAF details, right-click in the Receiver Options screen and select View » Detailed

Load an OAF

In the Receiver Options screen (Figure 56), ensure the following are correct:
* If you upload a universal OAF, make sure the expiration date is still valid.
* If you upload a customer OAF, make sure the correct customer file is loaded.

(Figure 57).

=" Receiver Options

EmEE|

Friendly Name

[Elers

[ElcLonass

Ga\i\eo

BeiDnu

[E]seas

[Elazss

Sate\me Tracking Channel Count

Dual Antenna Tracking
Co-op Tracking

Quar‘u Locked Loop

[E]Adaptive PLL

Mu\tipath Reduction

[Eloenss Mode

RTK Fositioning, Hz

ERTK Vertical Accuracy Level, cm
RTK Horizontal Accuracy Level, cm
Ma)umal Baseline Length, km
[£]Hp2 Mode

[E]p1on Mode

AutoSeed Mode

[ElomnisTAR service

Prec\se Positioning Mode
Inertia\ Integration

Pusltlon Update Rate, Hz

Memory, MB
-PPS Timing Signal

Flinnt Martnee

Current
Tracking
L1, 12, L5
L1, 12, L3
El, E5, E6
B1, B2, B3
L1, L5
L1, L2, L5, LEX Tracking, LEX Decoding
224

Raw Measurement Update Rate, Hz 100
Positioning

Yes
100
0
0
Mo restrictions
Heading and Pitch
Yes
Yes
VBS, XP, HP, G2
Code, Float, Fixed, Veripos
Yes
100
Interfaces
No Restrictions
Double

Cinaln

Permanent

L1, 12,15
L1, 12, L3

E1l, E5, E6

B1, B2, B3

L1, L5

L1, L2, LS, LEX Tracking, LEX Decoding
224

Mo restrictions

Heading and Pitch

Yes

Yes

VBS, XP, HP, G2

Code, Float, Fixed, Veripos
Yes

100

No Restrictions
Double

Cinaln

Leased |~ |

m

999
No restriction
Heading, Pitcl
Yes
Yes
VBS, XP, HP,

Yes
100

No Restrictior
Double

Rshin

<1

m

| b

Figure 56: Receiver Options

== Receiver Options

2_|o/x]

Friendly Name

[Elers

[ElcLonass

Eca\i\eo

BelDuu

[Elseas

Qzss
Sate\l\leTrackmg Channel Count
Dual Antenna Tracking
Cnrop Tracking
Quar‘z Locked Loop
[E]adaptive PLL
Mumpath Reduction

[Elraw measurement update Rate, Hz 100

[Eloenss mode

RTK Positioning, Hz

RTK Vertical Accuracy Level, cm
RTK Horizontal Accuracy Level, cm
EMammal Baseline Length, km
[E]HD2 Mode

DION Mode

AutoSaed Mode

OmniSTAR Service

Precise Positioning Mode
Inertial Integration

Posmon Update Rate, Hz

Memory, MB
PPS Timing Signal

o

Current
Tracking
L1, 12, L5
L1, L2, L3
El, E5, E6
B1, B2, B3
L1, L5
L1, L2, L5, LEX Tracking, LEX Decoding
224

Paositioning
Yes
100
0
o
No restrictions
Heading and Pitch
Yes
Yes
VBS, XP, HP, G2
Code, Float, Fixed, Veripos
Yes
100
Interfaces
No Restrictions
Double

Cinnln

Refresh
Upload OAF
SavetoFile ¥

Permanent

L1, 12,15
L1, 12, L3

El, E5, E6

B1, B2, B3

LL, L5

L1, L2, L5, LEX Tracking, LEX Decoding
224

Yes

® Overview

Detailed

No restrictions

Heading and Pitch

Yes

Yes

VBS, XP, HP, G2

Code, Float, Fixed, Veripos
Yes

100

No Restrictions
Double

Simaln

Leased —

i}

999

No restriction
Heading, Pitcl
Yes

Yes

VBS, XP, HP,

Yes
100

No Restrictior
Double

Prhlin

<]

1

Figure 57: Additional OAF Details
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The Receiver Options screen switches to a detailed view with additional information (Figure 58).

s ~
Friendly Name Opti... Current Permanent Leased b~
Tracking

[Elers _GPS  Yes Yes Yes 13
GPS L1 Signals GPS1  Yes Yes No

GPS L2 Signals GPS2  Yes Yes No 3
GPS L5 Signals GPS5  Yes Yes No

GLONASS _GLO  Yes Yes Yes 1/3(
GLDNASS L1 Signals GLO1  Yes Yes No

GLONASS L2 Signals GLO2  Yes Yes No
GLDNASS L3 Signals GLO3  Yes Yes No

_GAL  Yes Yes Yes 1/3(
GIOV  Yes Yes Yes 1/3(

Galileo E1 Signals GALL  Yes Yes No
Gal\len ES Signals GALS  Yes Yes No

Galileo E6 Signals GAL6  Yes Yes No
[E]eivou BED  Yes Yes Yes 1731
Ba\Dou B1 Signals BDS1 Yes Yes No
BE\DDU B2 Signals BDS2 Yes Yes No
BewDou B3 Signals BDS3  Yes Yes Mo

[SBAS WAAS  Yes Yes Yes 1/3(
[Elseas signals SBAS  Yes Yes No

SBAS L1 Signals SBA1  Yes Yes No
SBAS L5 Signals SBAS  Yes Yes No

Qzss QZSs  Yes Yes Yes 1/3(
QZSS L1 Signals QZ51 Yes Yes No

QZSS L2 Signals QZS2  Yes Yes No
QZSS L5 Signals QZS5  Yes Yes No

(QZSS LEX Signals Tracking QZS6  Yes Yes No
QZSS LEX Signals Decoding QZSL  Yes Yes No

L1 Tracking L1 Yes Yes Yes 1/31
L2 Tracking _L12_  Yes Yes Yes 1/3(
F=har Tracting 19 v vae vae 12
«| [T | »

Figure 58: Receiver Options — Detailed View

11. Click X to close the Receiver Options screen and return to the TRU main screen.
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Updating Firmware

Updating firmware on the receiver requires an Ethernet connection. If your unit has two B125 boards, each
board requires an update, and each board has a different IP address. The IP address for the main board is
192.168.0.9. The IP address for the auxiliary board is 192.168.0.10. Follow the below procedure for both
boards.
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@@ Do not unplug the power or Ethernet connection during the firmware update process.

1. Download the latest firmware build to your PC.
2. Open TRU and click Device » Application Mode » Receiver Managing.
3. Connect to the receiver using an Ethernet connection (Figure 59).

i 5

%, Connection Parameters 2| _ | 01| X|

Connect Using

lNetwarl-: v]

Device Name

MASTER (192.168.0.9:8002) E

Recewer Port

[7] Secondary Receiver

Serial A

Figure 59: TRU — Ethernet Connection

@g See “Connect to TRU Using Ethernet” on page 25 for more information.

4. Click Connect.
5. Once connected, click Device » Application Mode » Firmware Loading.
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6. Click the Firmware Loading icon. The Select Device screen appears (Figure 60).

5 Select Device

Device Type

2] ]o]x]|

[Receiver

-

Modem Firmware Form

Receiver Port

Internal Modem

Serial C

Capture Method
Soft Break

at

Native Modem Firmware

Serial Port Settings

Q
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c
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< Back I Next =

Cancel

Figure 60: TRU — Firmware Loading

7. Select Receiver from the Device Type drop-down list.

8. Click Next. The Information scree

5 Information

n appears (Figure 61).

Name
«# Target Device

= Receiver
@ Name
<% Firmware Version
@ \endor

= GNSS Board
& Model
@ Id
= Serial Number
<@ \ersion
@ Hardware Version

Value
Receiver

MR-2 MASTER
5.1 Oct, 12,2016 b13
Topcon

B125
D1WNASELO5K

B125_4
215

l < Back " MNext =

| |

Cancel

Figure 61: TRU — Receiver Information

9. Verify that the information is correct, and click Next. The Select Files screen appears

(Figure 62 on page 50).

Updating Firmware
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:\Users\dlangen\T opcon\OEM\MM-2\Firmware\timage_gnssFW5_1_b125.tfi 'Esvl

10. Click the folder icon, navigate to, and select the firmware build you downloaded in step 1. @)
@)

F = - N :

5 Select Files 2| -|olx| &

c

Image: a

=2

@)

o

< Back “ Mext > ] [ Cancel

Figure 62: Locate and Select Firmware

11. Click Next to the begin the upload.
Once the begins, a status screen appears (Figure 63). Do not unplug the power or Ethernet connection during
this process.

5 Installation - _ ﬂ A Q ﬂ

Current Status:
|Up|uading Flash

Figure 63: Firmware Upload In Progress
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12. When the upload ends, click Finish. A prompt appears indicating that the receiver is updating firmware
(Figure 64).
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5. The receiver is updating its firmware. Do not turn off the receiver

4 . until the firmware has been updated.

OK

Figure 64: Firmware Update In Progress

13. Wait approximately ten minutes for the process to finish.

14. Click OK to return to the Select Device screen.

15. Open the Terminal window in TRU.

16. Enter print dev/core:on and click Send.

During the update process, the receiver will return the following:

REOOF/par/dev/core={
REO1B 0={mode=normal,state=run},
REO1F 1={mode=update, state=updateX}}

@g For REO1F 1={mode=update, state=updateX}}, X will increase from 1 to 7.

When the update process is finished, the receiver will return the following:
REOOF/par/dev/core={

REO1B 0={mode=normal,state=run},

REOIB 1={mode=normal,state=run}}

17. Repeat steps 2-16 for the auxiliary board.
18. When both boards have been updates, disconnect from the receiver in TRU.
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The MR-2 receiver is suitable for a variety of applications from marine construction to surveying applications. The
MR-2 provides precise positioning, and heading and attitude information. This chapter describes different use
cases for the MR-2 receiver.

GNSS Modular Receiver

The MR-2 is a highly efficient GNSS sensor that you can integrate in various surveying and construction operations
where there are requirements for high accuracy, rapid deployment, and easy integration.

Serial communication available on this modular receiver provides full flexibility to connect to any external radio.
The primary antenna connection enables you to connect an external survey-grade antenna and use the receiver
as a rover suited to the job requirements.

Site Reference Station

You can integrate the MR-2 with an external radio using serial communication, and use it as a base receiver. As a
base, the MR-2 configuration can output RTK corrections in industry standard format for a rover receiver to
produce reliable and accurate RTK positions.

GNSS Sensor for Heading and Attitude

The MR-2 allows for the use of a dual antenna system, called HD2, that derives 2D attitude parameters (heading
and inclination) from the baseline vector between two antennas connected to the MR-2 receiver. Altogether, the
MR-2 can provide the high performance RTK position, heading, and pitch or roll of a vehicle or vessel where it is
deployed.
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Troubleshooting

This chapter will help you diagnose and solve some common problems encountered with the receiver.

® Do not attempt to repair equipment yourself. Doing so will void the warranty, and may damage the
hardware.

Check This First

Before contacting Topcon support, check the following:

® Register your product at https://www.topconpositioning.com/support.

* Check all external receiver connections carefully to ensure correct and secure connections. Double check for
worn or defective cables.

* Check the power source for incorrectly connected cables.

* Check that the most current software is installed onto the computer and that the most current firmware is loaded
into the receiver. Check the TPS website for the latest updates.

Then try the following:

* Reset the receiver using TRU (Tools » Resent Receiver).
* Restore default settings using TRU (Tools » Factory Reset).
If the problem persists, see the following sections for other solutions.

Powering Problems

If you are using an external power source, the cable may be disconnected or damaged.

* Make sure the cable is securely connected and undamaged.

* Make sure the power source is not defective.

* Using a volt meter, ensure power is present to the power source output connector.
* Power cycle the receiver. See “Power Cycling” on page 19 for more information.

Receiver Problems

The following are some of the most commonly encountered receiver problems.
The receiver cannot establish a connection to a computer or external controller.
Cable specific problems:

* The cable is not properly plugged in:
— Check that the cable connector is attached to the correct receiver port.
— Unplug the cable, then securely and properly reconnect it to the receiver.
* The cable is damaged:
— Use an undamaged cable. Contact a dealer to replace the cable.
Generic problems:
* The receiver port used for connection is not in Command mode:

a. Connect the receiver to a computer using a free port (see “Step 2: Connect to a Computer or Display
Unit and RTK Correction Source” on page 13) and start TRU.

b. Open TRU, and connect to the receiver. See “Connect The Receiver to TRU” on page 20.
¢. InTRU, click Receiver Settings » Ports.
Double-click on the port, and change the Input Mode to Command.
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The receiver does not lock on to satellites for a long period of time.
The corresponding receiver options may be disabled or expired (satellite signals must be enabled with OAFs).
* Order a new OAF with the desired options activated to enable or extend validity of the corresponding receiver
options. Contact a dealer or visit the TPS website for details.
¢ Refer to the 7TRU Online Help embedded in the software.
The receiver tracks too few satellites.

The survey is conducted near obstructions (tree canopy, tall buildings, and so forth).

* Check that the multipath reduction check boxes have been selected.
a. Connect the receiver to a computer using a free port (see “Step 2: Connect to a Computer or
Display Unit and RTK Correction Source” on page 13) and start TRU.
b. Open TRU, and connect to the receiver. See “Connect The Receiver to TRU” on page 20.
c¢. InTRU, click Receiver Settings » Tracking & Positioning » Adv tab.

d. Make sure the C/A code multipath reduction check box is selected.
* Move to an area free of obstructions, if possible.
The receiver cannot obtain Code Differential and/or RTK solutions.

* Incorrect Base coordinates entered.

— Specify the correct coordinates for the base station using TRU or another suitable field data collection
software.

The receiver is not configured as a Base or Rover.

— If the receiver should function as a Base, ensure it has the proper configuration. See “Configure the
Receiver as a Base” on page 27 for details.

— If the receiver should function as a Rover, ensure it has the proper configuration. See “Configure the
Receiver as a Rover” on page 35 for details.

* The corresponding receiver options may be disabled or expired.
— Order a new OAF with the required options activated to enable or extend validity of the corresponding

receiver options. Contact a dealer or visit the TPS website for details

— Refer to the 7RU Online Help embedded in the software.

* There are not enough common satellites. In order to obtain a fixed solution, the Base and Rover should track
at least five common satellites.

— Check the elevation masks of the rover and base receivers; they should be the same. To do this, on the
TRU main screen, choose Receiver Settings » Tracking & Positioning » Obs tab.

— Verify there is a clear view of the sky to allow sufficient satellite tracking.
¢ A discrepancy exists between the differential standards used at the base and rover receivers.
a. Connect the receiver to a computer using a free port (see “Step 2: Connect to a Computer or
Display Unit and RTK Correction Source” on page 13) and start TRU.
b. Open TRU, and connect to the receiver. See “Connect The Receiver to TRU” on page 20.
¢. InTRU, click Receiver Settings » Ports.

Double-click on the port to configure, and make sure the Input Mode of the rover matches the
format of the Output Mode of the base (i.e. RTCM 3.x) See “Configure the Receiver as a Rover”
on page 35 for more information.
* Poor satellite geometry (PDOP/GDOP values are too high). The recommended value is less than 3.5.
— Conduct a survey when PDOP values are low.
* The elevation mask is above 15 degrees:
— Lower the elevation mask. To do this, on the TRU main screen, click Receiver Settings » Tracking &
Positioning » Obs tab.
— Verify there is a clear view of the sky to allow sufficient satellite tracking.
¢ The transmitting and/or receiving antenna may be improperly connected:
— Check that the radio modem’s antenna is securely and properly connected to the antenna connector.
— Check that the radio modem’s antenna is undamaged. If damaged, contact a TPS dealer to replace the
antenna.

Receiver Problems P/N: 1011907-01
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The specified baud rate is incompatible with the baud rates the modem supports.
— The baud rate is the rate at which the receiver transmits differential messages to the modem and vice
versa.
— Change the baud rate to that which the modem supports. Refer to the modem’s manual for
information.
The base and rover modems use different radio link parameters.

— Configure the Base and Rover radio modems according to the procedures listed in the applicable
section. See the 7opcon Receiver Utility (TRU) Online Help, embedded in the software.

The distance between the base and rover is too far:
— Close the distance between the base and rover.
— Use repeaters to increase radio coverage.
There may be a source of radio interference that disrupts radio communications:
— Change the RF channel (if possible).
— Use a spectrum analyzer to detect the radio characteristics of the interfering signal and change the
system’s configuration accordingly.
— Remove the jamming signal source or relocate the radio antennas (if possible).
— The radio may not be properly connected to the receiver.
— Double-check all cable connections.

Clear NVRAM Using TRU

The receiver’s Non-volatile Random Access Memory (NVRAM) holds data required for satellite tracking, such as
ephemeris data and receiver position. The NVRAM also keeps the current receiver’s settings, such as active
antenna input, elevation masks, and recording interval.

Even though clearing the NVRAM is not a common (nor normally a recommended) operation, there are times
when clearing the NVRAM can eliminate communication or tracking problems. Clearing the receiver’s NVRAM
can be interpreted as a “soft boot” in the computer.

After clearing the NVRAM, the receiver requires time to collect new ephemerides and almanacs (around 15
minutes).

Clearing the receiver’s NVRAM will reset the receiver to factory default values.
To clear the NVRAM:

1.

4.

Connect the receiver and computer. See “Step 2: Connect to a Computer or Display Unit and RTK
Correction Source” on page 13 for this procedure.

Open TRU, and connect to the receiver. See “Connect The Receiver to TRU” on page 20.

Click the Tools icon in the main screen. The Tools dialog box appears, enabling you to reset the receiver
and clear the NVRAM.

Click Factory Reset, and then click Yes to continue.

Cleaning and Storing the Receiver

* Use a clean cloth moistened with neutral detergent or water.
* Never use an abrasive cleaner, ether, thinner benzene, or other solvents.
¢ Always make sure the receiver is completely dry before storing it. Dry any moisture with a soft, clean cloth.

Clear NVRAM Using TRU P/N: 1011907-01
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Safety Warnings

General Warnings

distances, angles and depths, and recording such measurements). This product should never be
used:
¢ Without the user thoroughly understanding this manual.

¢ After disabling safety systems or altering the product.
¢ With unauthorized accessories.

¢ Without proper safeguards at the survey site.

¢ Contrary to applicable laws, rules, and regulations.

' TPS receivers are designed for survey and survey related uses (that is, surveying coordinates,

Receiver Warnings

receiver’s warranty:
® Do not attempt to open the receiver and modify any of its internal components.
® Do not charge in conditions different than specified.
® Do not short circuit.

' Tampering with the receiver by the end users or non-factory authorized technicians will void the

Usage Warnings

otherwise treated without care, erroneous measurements may occur.
The owner should periodically test this product to ensure it provides accurate measurements.

' If this product has been dropped, altered, transported or shipped without proper packaging, or
Inform TPS immediately if this product does not function properly.
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Specifications

This chapter provides specifications for the MR-2 and its internal components.

General Details

Table 6 lists the MR-2's general specifications.

Table 6. General MR-2 Specifications

Physical
Enclosure Aluminum alloy
Color Topcon Yellow and Black

Dimensions (mm)

172 (w) x 166 (d) x 49 (h)

Weight (g) Single: 0.88 kg (1.94 Ibs)
Dual: 0.94 kg (2.07 Ibs)
Seals Silicon
Tracking
Number of 226 channels with universal tracking channels
Channels

Tracked Signals

GPS: L1 C/A, L1C, L1P(Y), L2P(Y), L2C, L5
GLONASS: L1 C/A, L1P, L2 C/A, L2P, L3C
Galileo: E1, E5a, E5b, E5AItBoc

Compass: B1, B2

SBAS Corrections: WAAS/EGNOS/MSAS
QZSS Nav: L1 C/A, L1C, L2C, L5C

L-band: Yes (1525 — 1560 MHz)

Antenna Type

External. Supports dual antenna input for heading determination through Topcon HD2
technology.

Multipath Yes, code and carrier

Reduction

PLL/DLL Setting Adjustable bandwidth and order
Smoothing Adjustable, code and carrier
Interval

Data and Memory

Internal Memory

Up to 8GB for each B125 board

Data Update /
Output Rate

Up to 100 Hz (20 Hz standard) (no interpolation)

Real-time Data
Output

Proprietary TPS format, RTCM SC104 ver. 2.x, 3.0, and 3.1; CMR/CMR+; MSM;
NMEA 0183 version 2.x, 3.0, and 3.0

Heading
Determination

Yes: simultaneous RTK + HD2

Data Logging

On-board data logging (for support purposes only) up to 8GB for each B125 board

Specifications
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Table 6. General MR-2 Specifications

Environment

Operating -10°Cto +75° C

Temperature

Storage -50° Cto +85° C

Temperature

Humidity 100%, condensing per MSP-PDA-012 class B, ref MRII-143
Waterproof Rating | IPX7 (1 meter submersion)

Dust Rating IP6X (fully dust proof)

Random Vibration

10-1014 Hz, 7.64q in all three axes

Sinusoidal 5-200 Hz, 8.9 g, in all three axes
Vibration

Shock 50 G, 6 -20ms pulse

Drop 3 ft. drop on concrete slab
Power

Internal Voltage
Range

9 to 36 VDC. Reverse Polarity Protected

Power
Consumption

Single: 5 watts @ 9-36 VDC (typical)
Dual: 8 watts @9-36 VDC (typical)
12 watts max

Power and Communications

Ports Deutsch DTM Series 12-pin
Receptacle for power and communications
Serial (x3), CAN, and PPS on main connector
Turck M12 8-Pin
Breaks out to RJ45 and SAE power
Antenna 2x TNC (Antenna power 4.75 — 5.10 VDC)
Connectors
LEDs 4 LEDs:
Power
Ethernet
Primary Antenna
Secondary Antenna
NMEA
NMEA Version Ver. 2.1, 2.2, 2.3, 3.0 output
Messages GGA, GLL, GNS, GRS, GSA, GST, GSV, HDT, RMC, VTG, ZDA, ROT, GMP
Output Interval 1 Hz standard; 5, 10, 20, 50, 100 Hz optional
DGPS

Correction Format

RTCM SC104 Ver. 2.1, 2.2, and 2.3

RTCM Message
Type

1, 3,9, 31, 32, 34; user selectable

Process Interval

1 Hz standard; 5, 10, 20, 50, 100 Hz optional

General Details
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Table 6. General MR-2 Specifications

Output Interval
for RTC
Correction Data

1 Hz standard; 5, 10, 20, 50, 100 Hz optional

Elevation Mask

0 to 90 degrees (independent of data logging)

Multi-base DGPS

Differential correction select mode: Nearest, Mix, Best (optional)

RTK

Correction
Format

RTCM SC104 Ver. 2.2, 2.3, 3.1, MSM

RTCM Message
Type

3, 18, 19, 20, 21, 22, +RTCM 3; user selectable

Ambiguity OTF

Initialize

Baseline Up to 50 km in the morning and evening
Strength Up to 32 km at noon

Accuracy (rms)?

Standalone Horizontal: 1.2 m
Vertical: 1.8 m
RTCM based Horizontal: 0.3 m
DGPS Vertical: 0.5 m
SBAS Horizontal: 0.8 m
Vertical: 1.2 m
OmniSTAR Horizontal: 0.7/0.15/0.1 m
VBS/XP/HP
PPP Horizontal: 0.05 m

(TerraStar-D)

Vertical: 0.1 m

Static/Fast Static

Horizontal: 3 mm + 0.5ppm (x baseline length)
Vertical: 5 mm + 0.8ppm (x baseline length)

RTK Static

Horizontal: 3 mm + 0.5ppm (x baseline length)
Vertical: 5 mm + 0.8ppm (x baseline length)

RTK Kinematic/

Horizontal: 5 mm + 0.5ppm (x baseline length)

Stop&Go/ Vertical: 10 mm + 0.8ppm (x baseline length)

Network

Heading 0.3°/D, where D is the inter-antenna distance in meters.
Inclination 0.5°/D, where D is the inter-antenna distance in meters.
Velocity 0.02 m/sec

Time 30 nsec

Time to First Fix
(50%)

Hot (almanac, recent ephemeris, and approx. position) <10 sec
Warm (almanac, approx. position & time, and no recent ephemeris) <35 sec
Cold (no almanac or ephemeris, and no approx. position or time) <60 sec

Reacquisition

<1 sec

General Details
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a. These specifications wills vary depending on the number of satellites used, obstructions, satellite geometry (PDOP),
occupation time, multipath effects, and atmospheric conditions. Performance may be degraded in conditions with high
ionospheric activity, extreme multipath, or under dense foliage. For maximum system accuracy, always follow best
practices for GNSS data collections.

Connector Specifications
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The MR-2 has two antenna connectors, and one port connector for power and data upload/download.
Main Connector

The power connector (Figure 65) is a sealed receptacle, Deutsch DTM Series 12-pin connector located on the
front of the receiver.

(olofololofo
(ofefo]ofofe)

\;
PIN 6 PIN 1

Figure 65: Power Connector

PIN 71 PIN 12
‘ @

Table 7 provides the power connector specifications.

Table 7. Main Connector Specifications

No. Signal Direction
Name
1 GND_IN Ground Input
2 PWR_IN Power Input
3 TXD1 Output
4 RXD1 Input
5 RXD2 Input
6 TXD2 Output
7 GND Ground
8 IGN Input
9 CAN_H1/2 | Input/Output
RXD3
10 CAN_L1/ Input/Output
TXD3
11 PPS Pulse Per Second Output
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Table 7. Main Connector Specifications

a. COM 3 attaches to a secondary B125 board.

wn
o)
Signal 1
No. 9 Direction o,
Name =h
0
12 GND Ground g.
@]
-
)

Ethernet Connector

The Ethernet connector is a sealed receptacle located on the front of the receiver.

SHIELD
PIN 6
PIN 7
PIN 5
PIN 4
PIN 1
PIN 8 PIN 2
PIN 3

Figure 66: Ethernet Connector
Table 8 provides the Ethernet connector specifications.

Table 8. Ethernet Connector
Specifications

Signal

No.
Name

[0} N [e)} (&) » w N
<
+
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Cable Harness

Cable Harness Receiver End Connector

PIN 12 PIN 7
ﬁ‘ﬁg
/Q o 0 0 O .\

PIN 1 PIN 6
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Figure 67: Cable Harness Receiver Connector
Table 9 provides pin out specifications for the receiver end of the cable harness.

Table 9. Cable Harness (Receiver End) Specifications

No. Signal Direction
Name
1 GND_IN Ground Input
2 PWR_IN Power Input
3 TXD1 Output
4 RXD1 Input
5 RXD2 Input
6 TXD2 Output
7 GND Ground
8 IGN Power Input
9 COM3 Input
10 COM3 Output
11 PPS Pulse Per Second Output
12 GND Ground
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Cable Harness Power Connector
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PIN A/gg’/\ PIN B

Figure 68: Cable Harness Power Connector
Table 10 provides pin out specifications for the power connector of the cable harness.

Table 10. Cable Harness Power Arm
(Receiver Side) Specifications

No. Signal Name
A Vin
B GND
C IGN
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Cable Harness COM1 Connector

Table 11 provides pin out specifications for the COM1 connector of the cable harness.

PIN 1 —_|

PIN5 —

B

)

5000

_— PING

900060

G

~— PIN 9

o

Figure 69: Cable Harness COM1 Connector

Table 11. Cable Harness COM1 Connector Specifications

No. gzznizl Level Direction

1 N/C _ _

2 TXD1 RS232 o/P

3 RXD1 RS232 /P

4 N/C - -

5 GND GND GND

6 N/C - _

7 CTS RS232 Connected to
Pin 8

8 RTS RS232 Connected to
Pin 7

NC | - = -

Connector Specifications
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Cable Harness COM2 Connector
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Figure 70: Cable Harness COM2 Connector
Table 12 provides pin out specifications for the COM2 connector of the cable harness.

Table 12. Cable Harness COM2 Connector Specifications

RS232

- Level Direction
Signal

No.

—

N/C - -
TXD2 RS232 o/P

RXD2 RS232 I/p

N/C - -

GND GND GND

N/C - -

N/C - -
N/C - -
N/C - -

Ol N|loo|lun| DMl W[IDN
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Power Adapter Connector

PIN B

PINA

Figure 71: Power Adapter Cable
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Table 13 provides pin out specifications for the power adapter connector of the optional power adapter cable.

Table 13. Power Adapter Connector
Specifications

No. R_5232
Signal
A PWR_IN
B GND_IN
C IGN
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Ethernet Cable L
8.
SHIELD 5
PIN 6 g
PIN 5
PIN 7
PIN 1
PIN 4
PIN 8 PIN 3
PIN 2

Figure 72: Ethernet Cable - Receiver Side
Table 14 provides pin out specifications for the receiver side of the optional Ethernet cable.

Table 14. Receiver Side Ethernet Cable
Specifications

No. Signal Level Direction
Name
1 PWR Power
2 PWR_GND Power/Ground
3 PWR_GND Power/Ground
4 TX-
5 RX+
6 TX+
7 PWR Power
8 RX-
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Regulatory

The following sections provide information on this product’s compliance with government regulations for use.
FCC Compliance

This equipment has been tested and found to comply with the limits for a Class A digital device pursuant to part
15 of the FCC rules. These limits are designed to provide reasonable protection against harmful interference when
the equipment is operated in a commercial environment. This equipment generates, uses, and can radiate radio
frequency energy and, if not installed and used in accordance with the instruction manual, may cause harmful
interference to radio communications. Operation of this equipment in a residential area is likely to cause harmful
interference in which case the user will be required to correct the interference at his own expense.

If this equipment does cause interference to radio or television equipment reception, which can be determined by
turning the equipment off and on, the user is encouraged to try to correct the interference by one or more of the
following measures:

* Reorient or relocate the receiving antenna.

* Move the equipment away from the receiver.

* Plug the equipment into an outlet on a circuit different from that to which the receiver is powered.
Consult the dealer or an experienced radio/television technician for additional suggestions.

Any changes or modifications to the equipment not expressly approved by the party responsible for
compliance could void your authority to operate such equipment.

Industry Canada Compliance

This class A digital apparatus complies with Canadian ICES-003.
Cet appareil numeérigue de la classe A est conforme a la norme NMB-003 du Canada.

This device complies with Industry Canada license-exempt RSS standard(s). Operation is subject to the following
two conditions: (1) this device may not cause interference, and (2) this device must accept any interference,
including interference that may cause undesired operation of the device.

Le présent appareil est conforme aux CNR d'Industrie Canada applicables aux appareils radio exempts de licence.
L'exploitation est autorisée aux deux conditions suivantes : (1) 'appareil ne doit pas produire de brouillage, et (2)
I'utilisateur de I'appareil doit accepter tout brouilage radioélectrique subi, méme si le brouillage est susceptible
d’en compromettre le fonctionnement.
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Community of Europe Compliance

The product described in this manual is in compliance with the R&TTE and EMC directives from the European
Community.

A1ojen3ay

European Community Declaration of Conformity

The following declares that this device conforms to the R&TTE Directive 1999/5/EC and Motor Vehicle EMC
Directive 2004/104/ec.

The following standards were applied: (R&TTE Directive 1999/5/EEC and Motor Vehicle EMC Directive
2004/104/ec)

* EN 301 489 V1.9.2 (2011-09)

* EN 60950-1: 2006 + A11:2009/A1:2010/A2:2013

e EN 301 489-3 V1.61 (2013-08)

* EN 300 440-2 V1.4.1

e EMC Directive 204/104/ec
The following CE mark is affixed to the device:

C€

This is a Class A product. In a domestic environment this product may cause radio interference in
which case the user may be required to take adequate measures.

Declaration of Conformity (R&TTE Directive 1999/5/EC)

esky [Czech] | |(7opcon)timto prohlasuje, ze tento (MR-2) je ve shod se zakladnimi
pozadavky a dalsimi pisluSnymi ustanovenimi smrnice 1999/5/ES.

Dansk Undertegnede (7opcon) erklaerer herved, at fglgende udstyr (MR-2)

[Danish] overholder de vaesentlige krav og gvrige relevante krav i direktiv
1999/5/EF.

Deutsch Hiermit erklart (7opcon) dass sich das Gerat (MR-2) in Ubereinstimmung

[German] mit den grundlegenden Anforderungen und den Ubrigen einschlagigen
Bestimmungen der Richtlinie 1999/5/EG befindet.

Eesti Kaesolevaga kinnitab (7opcon) seadme (MR-2) vastavust direktiivi

[Estonian] 1999/5/EU pohinduetele ja nimetatud direktiivist tulenevatele teistele
asjakohastele satetele.

English Hereby, (7Topcon) declares that this (MR-2) is in compliance with the
essential requirements and other relevant provisions of Directive
1999/5/EC.

Espariol Por medio de la presente (7opcon) declara que el (MR-2) cumple con los

[Spanish] requisitos esenciales y cualesquiera otras disposiciones aplicables o

exigibles de la Directiva 1999/5/CE.

[Greek] L
ME THN MAPGYZA (Topcon Positioning Systems,

Inc.) AHAQNEIOTI ( MR-2) ZYMMOPOQNETAIL
MPOZ TIZ OYZIQAEIZ AMAITHZEIZ KAL TIZ ACIMNEZ
ZXETIKEZ AIATAZEIZ THZ OAHITAZ 1999/5/EK.
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Frangais Par la présente (7opcon) déclare que I'appareil (MR-2) est conforme aux

[French] exigences essentielles et aux autres dispositions pertinentes de la
directive 1999/5/CE.

Italiano Con la presente (7opcon) dichiara che questo (MR-2) & conforme ai

[Italian] requisiti essenziali ed alle altre disposizioni pertinenti stabilite dalla
direttiva 1999/5/CE.

Latviski Ar So (Topcon) deklar, ka (MR-2) atbilst Direktvas 1999/5/EK btiskajm

[Latvian] prasbm un citiem ar to saisttajiem noteikumiem.

Lietuvi Siuo (Topcon) deklaruoja, kad $is (MR-2) atitinka esminius reikalavimus

[Lithuanian] ir kitas 1999/5/EB Direktyvos nuostatas.

Nederlands Hierbij verklaart (7opcon) dat het toestel (MR-2) in overeenstemming is

[Dutch] met de essentiéle eisen en de andere relevante bepalingen van richtlijn
1999/5/EG.

Malti [Maltese] | \Hawnhekk, (7opcon), jiddikjara li dan (MR-2) jikkonforma mal-tiijiet
essenzjali u ma provvedimenti orajn relevanti li hemm fid-Dirrettiva
1999/5/EC.

Magyar Alulirott, (7Topcon) nyilatkozom, hogy a (MR-2) megfelel a vonatkozo

[Hungarian] | alapvetS kovetelményeknek és az 1999/5/EC iranyelv egyéb eldirasainak.

Polski [Polish] || Niniejszym, (Topcon) , deklaruj, e (MR-2) spenia wymagania zasadnicze
oraz stosowne postanowienia zawarte Dyrektywie 1999/5/EC.

Portugués (Topcon) declara que este (MR-2) esta conforme com os requisitos

[Portugues] essenciais e outras disposicoes da Directiva 1999/5/CE.

Slovensko (Topcon) izjavlja, da je ta (MR-2) v skladu z bistvenimi zahtevami in

[Slovenian] ostalimi relevantnimi doloili direktive 1999/5/ES.

Slovensy (Topcon) tymto vyhlasuje, ze (MR-2) spa zakladné poziadavky a vSetky

[Slovak] prislusné ustanovenia Smernice 1999/5/ES.

Suomi (Topcon) vakuuttaa taten etta (MR-2) tyyppinen laite on direktiivin

[Finnish] 1999/5/EY oleellisten vaatimusten ja sitd koskevien direktiivin muiden
ehtojen mukainen.

Svenska Harmed intygar (7opcon) att denna (MR-2) stér I dverensstammelse

[Swedish] med de vasentliga egenskapskrav och 6vriga relevanta bestammelser

som framgar av direktiv 1999/5/EG.

WEEE Directive

Following information is for EU-member states only:

The use of the symbol below indicates that this product may not be treated as household waste. By ensuring
this product is disposed of correctly, to help prevent potential negative consequences for the environment and
human health, which could otherwise be caused by inappropriate waste handling of this product. For more
detailed information about the take-back and recycling of this product, please contact a supplier where you
purchased the product or consult.
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Warranty

Topcon laser and electronic positioning equipment are guaranteed against defective material and workmanship
under normal use and application consistent with this Manual. The equipment is guaranteed for the period
indicated, on the warranty card accompanying the product, starting from the date that the product is sold to the
original purchaser by Topcon’s Authorized Dealers.!

During the warranty period, Topcon will, at its option, repair or replace this product at no additional charge. Repair
parts and replacement products will be furnished on an exchange basis and will be either reconditioned or new.
This limited warranty does not include service to repair damage to the product resulting from an accident, disaster,
misuses, abuse or modification of the product.

Warranty service may be obtained from an authorized Topcon warranty service dealer. If this product is delivered
by mail, purchaser agrees to insure the product or assume the risk of loss or damage in transit, to prepay shipping
charges to the warranty service location and to use the original shipping container or equivalent. A letter should
accompany the package furnishing a description of the problem and/or defect.

The purchaser’s sole remedy shall be replacement as provided above. In no event shall Topcon be liable for any
damages or other claim including any claim for lost profits, lost savings or other incidental or consequential
damages arising out of the use of, or inability to use, the product.

1. The warranty against defects in a Topcon battery, charger, or cable is 90 days.
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Glossary

Glossary

BDS — BeiDou Navigation Satellite System maintained and operated by China. See also, BeiDou.

Base Station — A GNSS receiver set up over a known point, which is used to derive correction information for
nearby Rover (mobile) GNSS receivers.

BeiDou — Navigation Satellite System maintained and operated by China. See also, BDS.

C

G

GALILEO - The satellite system currently being maintained and operated by the European Union (EU) and
European Space Agency (ESA).

GGD - GPS + GLONASS Dual Frequency signal tracking.

GLONASS — The GLObal NAvigation Satellite System maintained and operated by the Russian Federation.
GNSS — Global Navigation Satellite Systems, such as GPS and GLONASS.

GPS — The Global Positioning System maintained and operated by the United States Department of Defense.
L

L1 - The primary L-band carrier used by GPS and GLONASS satellites to transmit satellite data.

L2 — The secondary L-band carrier used by GPS and GLONASS satellites to transmit satellite data.

Light-Emitting Diode (LED) — Used as indicator lights on the receiver to display the status of the receiver’s
components and control receiver operations.

MAGNET Field™ — Data controller software that is part of the MAGNET software system.

MAGNET Office™ — Post-processing and CAD solution software for surveying and grade application. It is part of
the MAGNET software system.

MINTER - The receiver’s Minimum INTERface used to display and control data input and output.

Network RTK — Collects satellite observations from the reference stations within the network and sends RTK
corrections to the Rover.

0

Option Authorization File (OAF) — This enables the specific features that a customer purchases.

P

Phase Center of Antenna — The point from which the electromagnetic radiation spreads spherically outward,
with the phase of the signal being equal at any point on the sphere.

Pocket-3D — Field controller software by Topcon that supports both GNSS and TS.
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Real-Time Kinematic (RTK) — A precise method of real-time surveying. RTK enables you to check the
measurement quality without having to process the data.

Root Mean Square (RMS) — Statistical measure of the magnitude of a varying quantity.
Rover — A mobile GNSS receiver and data collector used for determining location in the field.

S

Satellite-Based Augmentation Systems (SBAS) — Complements existing global navigation systems.
SBAS transmits differential corrections and messages for navigation satellites that are within sight of a
network or reference stations in a wide area, such as a continent.

Static Survey — Typically uses a network or multiple baseline approach for positioning. This method
provides the highest accuracy and requires the longest observation times.

T

Topcon Receiver Utility (TRU) — Hardware configuration software for receivers and peripheral devices.
TRU is available for download from myTopcon (https://www.topconpositioning.com/support).

u
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